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Understanding Comment Banks 
• Comment banks store pre-defined comments or phrases frequently used when teachers are writing comments for student reports. By 

calling upon banks of comments already written, the manual drudgery of comment writing is reduced. The pre-defined comments are 
able to be used as the basis of more complex and personalised final comments for each student. 

• Special control text is inserted into comments so that, when linked to a particular student, the comments are personalised, showing 
the student’s name and/or appropriate pronoun. 

• There are two levels of comment banks – school and teacher. The former are set up and managed by Accelerus Administrators or 
Subject Coordinators, and assigned to appropriate subjects in the Accelerus database. Teacher comment banks are created and 
controlled by teachers. 

• Comment banks are not separate files but form part of a teacher’s offline file. When offline class files are exported or collected, 
comment banks that have been associated with the class also form part of the offline file. Any changes made to the comment bank, 
eg by the Accelerus administrator, will be updated with other changes when the teacher synchronises their offline file. 

• Comment banks in Accelerus have a hierarchical structure. Firstly, you should have broad banks of comments, eg one for English, 
one for Maths, a general or work habits bank, etc. 
Then, within each comment bank there is a structure of categories which have values, which in turn have comments, eg: 

 
Categories Values Comments 
Writing Folio High {He/She/Name} has submitted an excellent folio 

{His/Her/Name's} writing folio showed an ability to express complex ideas in fluent 
pieces of writing. 
… 

Medium  {His/Her/Name's} writing folio was of a satisfactory level. 
Although {he/she/Name} submitted a good folio, {he/she} needs to put in more effort. 
… 

Low {His/Her/Name's} writing folio was not of the standard expected. 
… 

Projects Excellent Appropriate comments 
… 

Good Appropriate comments 
... 

... ... 
... ... ... 

Exploring Comment Banks 

Comment banks have an Explorer through which 
they may be opened and modified. 

This Explorer may be accessed from the Welcome 
Screen by teachers by clicking the Comment bank 
explorer icon in the bottom right of the screen. 

The Comment Bank Explorer will list comment 
banks available to the teacher currently logged in. 
For example, a teacher may see the teacher 
comment banks he or she has created, plus any 
school comment banks that have been assigned to 
the subjects taught by the teacher, by the Accelerus administrator. 

However, teachers may only make changes to the comment banks they own. School comment banks may only be viewed, printed and 
exported out of Accelerus, once opened in the Comment Bank window. 

At the bottom of the Comment Bank Explorer, is a series of icons that allow: 
• Comment banks to be opened. 
• Printing out a listing of the comments in the comment banks. 
• The importation of comment banks, in either CSV or MarkBook .cdb format. 
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Creating a new comment bank 
• Run Accelerus, by double-clicking the Accelerus icon on your desktop. 

• Login in the same way as you do to work on your 
classes. 

• In the Welcome Screen, click the Comment bank 
explorer icon. 

• When in the Explorer, click the New teacher comment 
bank icon in the bottom left of the window. 
OR 

• From the File menu, select New > Comment Bank > 
Teacher Comment Bank. 

• Double-click where blank comment bank name is displayed in the top 
left pane and type in the name of the comment bank. 
In the examples shown below, the comment bank has been called 
Work Habits. 

• With the comment bank name highlighted, click the Add category icon 
below the top left-hand pane. 

• In the blank field that appears, enter the category name, eg 
Homework. 

• Add further categories by clicking the Add category icon. 

• Click the category to which you want to add values and then click the 
Add value icon. 

• Enter the name of the value in the blank field below the selected category. 

• Continue adding values, as required. 

 
 

 
 
 

In the examples shown above, the Work Habits bank has a category called Homework which has two values, so far – Excellent and 
Very Good. There is also a Behaviour category 
without any values as yet. 

• If necessary, move any values into the correct 
order, by clicking the Move up and Move down 
icons. 

• With the value belonging to a category highlighted, 
click the New comment icon under the Comment 
table. 

• Type the comment required in the Comment cell. 

• In the locations where the student’s name or 
appropriate pronoun should appear, click the Insert 
student name/pronoun icon. 
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• In the Name/Pronoun Substitution box which appears as shown 
here: 

• Select the required pronoun and name option buttons 
required, with an example of the substitution text appearing in 
the bottom left corner, eg {He/She/Name}. 

• Click the Pronoun Only or Name Only checkboxes, where you 
want to limit the substitution, eg {he/she} or {Name}. 

• Select the correct case option, eg lower case {he/she} where it 
is to appear in the middle of a sentence. 

• Click the OK button to insert the selected substitution text in 
the comment. 

OR 
• You may manually enter the required substitution text: 

• Type the open brace icon, ie {. 
• This will bring up a dropdown list of available options from 

which you may choose the correct substitution, eg 
{His/Her/Name’s}. 

• Type as much of the substitution text as you wish and, as you 
do so, the dropdown list will only reflect the options that 
match. 

• Continue adding comments, as required. 

• Click the Save icon or press Ctrl S to save your comment bank. 

• Spell check the comment bank: 

• Click the comment bank name in the left pane. 
• Go to the Edit menu and select Spell Check or press 

F7 to start the spell check operation. 
• Work through any errors indicated in the Spelling 

and Punctuation window, choosing the appropriate 
option such as to ignore errors, add the spelling to 
the dictionary, select from suggestions or enter 
replacement text. 

• If you require a printed listing of the comment bank: 

• Go to the Comment Bank menu and select 
Comment Bank Listing. 

• Preview the listing, moving through its pages and 
performing other preview processes, as required. 

• Click the Print icon in the preview window. 
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Editing and deleting comments 

Opening an existing comment bank 
Comment banks created by you will be listed in the Comment Banks section of the Welcome Screen. Click on the comment bank you want 
to edit, to open it in the Comment bank window. 

Editing 
Standard editing tools (eg cut, copy, paste) are available in the Comments section. Right-
click to display the menu. 

To change the name of the comment bank or of any category or value: 

• Double-click on the comment bank name, category or value that you want to 
change. 

• Enter the new name. 
 

Deleting 
To delete a comment bank, a category or a value: 

• Highlight the particular category or value to be deleted. 

• Click the Delete icon at the bottom of the left pane. 
A confirmation message will appear, informing you of the extent of the deletion, ie 
how many categories, values and comments will be deleted, if you proceed. For 
example, when deleting a category, you are also deleting its values and all of the 
comments for the category. 

• If you click OK at the confirmation message, red lines will appear through the 
category, values and comments to be deleted when you save the comment bank. 

To delete a comment row: 

• Select the row you want to delete. 
OR 

• Hold down the Ctrl key and click individual rows. 
OR 

• Hold down the Shift key and select the last row in a contiguous group to be 
deleted. 

• Click the Delete icon at the bottom right of the Comments table. 
 
 
 

Reordering 
You may change the order of any of the categories, any of the values or any of the comments. 
It’s best to have the most useful or commonly-used comments at the top of the list, to make it 
easier when drawing upon them in Single Student view. 

• Click the category, value or comment you wish to move up or down. 

• Click the Move up or Move down arrows icons applicable to the appropriate section, until 
it is positioned in the correct place. 
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Using comment banks 
Comment banks that have 
been set up by teachers or 
assigned to teachers’ 
classes by the Accelerus 
Administrator are stored in 
the teachers’ offline files so 
that they may be drawn 
upon when assessing 
students. 

This is done in Single 
Student View, with any 
available comment banks 
being displayed in the 
comment bank panel. 

The school comment banks 
will appear greyed out so 
that they may not be 
changed, but can be drawn 
upon. 

Comment banks owned by 
the teacher may be 
modified and drawn upon. 
As shown here, there are 
two school comment banks 
– Generic and Maths – plus 
Maths 7-9 and Work Habits, 
both of which are teacher 
comment banks. 

To use the comment banks: 

• Click in the particular comment box for which you want to compose comments, eg T1COM – Interim 1 comment above. 

• Click on the comment bank that you want to draw comments from, eg Work Habits. 

• Click on a category of the 
comment bank, eg General 
Performance, 
Organisational Skills, etc. 
All of the comments for that 
category will be displayed, 
with their values. 

• Click on a performance 
value for the category, eg 
Satisfactory, and the comments for that 
Category and Value will appear in the 
Comment table. 

• Change the name substitution mode by 
clicking the Name or Pronoun button, if 
necessary. 

• If buttons appear for Given name and 
Preferred name, click the required option 
to display the comment with the chosen 
name format. 
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• Double-click a comment in the table to insert it into the comment box. 

• Continue selecting comments in the same way for the current student. 

• Do as much editing and 
changing of the text in 
the comment box as you 
wish – right-clicking 
brings up an edit menu, 
or use short-cuts. 

• Correct spelling errors as 
you go when squiggly red 
underlining appears, 
right-clicking on the 
misspelt word to bring up 
alternatives. 

• Click the Next or Previous student arrows to move down or up the student list. 
OR 

• Press Alt N or Alt P respectively. 

• Keep entering comments for students in the same way. 

• Click the Save icon or press Ctrl S regularly to ensure the comments you have been entering are saved. 
 

 

Your school may have activated a setting that does not allow you to type beyond the number of characters specified for a 
particular comment. In this case, any comment you insert, that would take you beyond the comment’s maximum 
characters, will be truncated. 

Alternatively, the school setting may allow you to continue entering comments but the comment box will be shaded red 
and the comment will need to be edited to fit within the number of characters before you can save the offline file. 
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Building comment banks from selected text 
As you are composing a student’s comment in Single Student view, you may wish to preserve the comment in an existing comment bank, 
with substitution text, so that it is available for future use. Having composed a comment for a student in a particular comment item: 

• In the comment bank pane, click on the 
comment bank and the particular 
category and value to which you want 
to add the comment. 

• Highlight all or the portion of the 
comment you composed that you want 
to add to the comment bank. 

• Click the New comment from selected 
text icon at the bottom of the Comment 
table. 
The Comment table moves into 
comment bank edit mode and the new 
comment will be added to the table for 
the selected category and value. 
Accelerus attempts to insert 
appropriate name/pronoun substitution 
text where the student’s name or a 
pronoun has been used, as shown 
below right. 

• Make any changes to the comment, if 
required, in the new Comment table 
row. 

• If required, while in comment bank edit mode, add further 
comments to the bank: 

• Click the required comment bank, category and 
value. 

• Click the New comment icon. 
• Insert name/pronoun substitution text in the 

comment, in appropriate places, by clicking the 
Insert student name/pronoun icon. 

• When finished editing the comment bank’s comments, click 
the Edit icon to exit comment bank edit mode. 

• Save the changes by clicking the Save icon. 
 
 
 
 
 
 
 

Other handy tools 
What How 

Spell check a comment bank Edit menu > Spell Check; or press F7. 

Print a listing of all the comments in a comment bank. Comment Bank menu > Comment Bank Listing 

Import already created banks of comments in CSV files 
or MarkBook comment banks. 

Welcome Screen > Comment Bank Explorer icon > Import icon, or 

File > Import > Teacher Comment Bank. 


